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Information about this operating manual

This operating manual is designed to enable you to use the HumiSenseWare effectively 
and it must be easily accessible to users at all times. All users are required to carefully 
read and make sure that they have understood this operating manual before using the 
HumiSenseWare.

All of the information and instructions provided in this operating manual have been 
compiled on the basis of the current standards and regulations, the state of the art, 
and the extensive expertise and experience of Schaller Messtechnik GmbH.

Schaller Messtechnik GmbH does not accept any liability for damage associated with 
the following, which also voids the warranty:

•	 Non-observance of this operating manual

•	 Improper use

•	 Inadequately qualified users

We, as the manufacturer, do not accept any liability for any incorrect measurements 
and associated consequential damage.
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1.	 System requirements

The HumiSenseWare needs the following system requirements:

Requirements

Operating system Windows 7 SP1 
Windows 10 (>1607) 
Windows Server 2008 R2 
Windows Server 2012 R2 
Windows Server 2016

Installed software .NET runtime 4.6.2

Hard disk space min. 500MB free 
(including runtime)

Screen resolution recommended min.: 1024 x 768 
limited use: 800 x 600

2.	 Installation

To do so: The runtime and the HumiSenseWare installers have to be on your computer 
or on a USB-Stick plugged into your computer.

2.1	 Operating system older than Win 10

If the operating system is older than Microsoft Windows 10 the ".NET runtime 4.6.2" 
needs to be installed before.

2.1.1	 Installing the .NET runtime 4.6.2

1.	 Navigate to the directory where the .NET runtime installer is located.

	» The runtime .NET runtime installer is called "ndp48-x86-x64-allos-enu.exe".

2.	 Execute the .NET runtime installer.

3.	 Follow the instructions of the installation wizard.

4.	 After the successful installation, close the installation wizard with Finish.

	» Now you can install the runtime.
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2.2	 Installing runtime

1.	 Navigate to the directory where the 
runtime installer is located.

	» The runtime installer is called "lvrtxxxx-
x86.nsis.exe".

2.	 Execute the runtime installer.

3.	 Follow the instructions of the installation 
wizard (figure 1).

4.	 After the successful installation, close 
the installation wizard with Finish.

	» Now you can install the HumiSenseWare software.

2.3	 Installing HumiSenseWare

To do so: The runtime has to be installed on your computer.

1.	 Navigate to the directory where the 
HumiSenseWare installer is located.

	» The HumiSenseWare installer is called 
"HumiSenseWare-xxxxxxxx-xxxx.exe".

2.	 Execute the HumiSenseWare installer.

3.	 Follow the instructions of the installation 
wizard (figure 2).

4.	 After the successful installation, close 
the installation wizard with Finish.

	» HumiSenseWare should now be installed on your computer.

 1 

 2 
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2.4	 Overview of the HumiSenseWare window

No Name

1 Stop measurement with selected sensor

2 Start measurement with selected sensor

3 Menu bar

4 Adjust for MF-P-HTD

5 Measured values database

6 General settings

7 Language selection German and English

8 Sensor table

9 Measured value diagram (live trend)

1

3

4
5
6
7

8 9

2
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2.5	 Licencing

To do so: The HumiSenseWare software is already installed and running on the desired 
computer.

In the software HumiSenseWare different modules can be licensed. For more informa-
tion please contact our sales department. 
 
At the first start of the software, a demo license is created, which is valid for one day. 
This can be extended at any time or converted into a full license.

1.	 To perform the licensing, start the 
HumiSenseWare software on the target 
computer and select the menu item 
"View" > "Licencing" (Figure 3).

2.	 Click on the e-mail button (Figure 4). 
The Windows standard e-mail program 
should then open automatically - the 
license request can be sent.

	» If it is not possible to send an e-mail on 
the target computer, please click on the 
license button - then the license request 
can be sent.

	» You can then paste it e.g. in the Win-
dows text editor, and save it in a textfile. 
Please send this textfile to  
HumiSenseWare@humimeter.com.

3.	 Now we can do the licensing for you.

4.	 You will then receive an e-mail from us with the license.  
This text snippet looks something like this: 
 
<licence>FA12345689567D89742AAEE03FC8197E20BF6AE1119365DA787CE4F
BEBF6454E5F73ACC8EC247D945BB</licence>

 3 

 4 
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Please copy this text snippet via the clipboard into the license window.

If, no e-mail is possible on the target computer, then follow the instructions below:

	» License text snippet <licence>.....</licence> from e-mail to text file via editor

	» Copy text file to USB stick

	» Open text file with editor on target computer

	» Open license window in HumiSenseWare

	» Copy text snippet to clipboard

	» The license window recognizes the license in the clipboard and will be inserted 
automatically

	» Click on the OK button (green check mark)

Ready! 
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3.	 Setting up

3.1	 Adding a sensor

To do so: The runtime and HumiSenseWare must have been installed. 

1.	 Right-click on the sensor table.

2.	 Select the option "Change" and then "Add" (figure 5).

	» The "Edit Sensor" window will now open (figure 6) and you 
are able to add a sensor.

	» Here you can enter your sensor-configuration (see 3.1.1 The 
fields of the "Edit Sensor" window).

3.	 Save the sensor by pressing .

4.	 Cancel adding a new sensor by pressing . 
 

3.1.1	 The fields of the "Edit Sensor" window

Field Description

Name Is the name of the sensor that will be shown and is 
set automatically but it can be changed

Autostart? Enables the automatic start of a measurement when 
HumiSenseWare is started

Type see 3.1.2 Sensor types

Interval (ms) Sets the measurement readout-interval of the sensor

Predefined intervals which can be selected from a 
dropdown-list or a custom interval can be entered 

Database Interval Sets the database storage interval for the sensor

Address Sets the sensor address: IP / hostname / COM-Port

TwinCAT ADS Only for setting up a Beckhoff TwinCAT ADS commu-
nication

 5 

 6 
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3.1.2	 Sensor types

Simulation

Simulates a real sensor with randomised moisture and temperature 
values.

Real sensor

One of the different sensor types compatible with the HumiSenseWare (Figure 7).

3.2	 Example: setting up a "humimeter BLO" sensor

1.	 Right-click on the sensor table.

2.	 Select the option "Change" and then 
"Add".

	» The "Edit Sensor" window will now 
open.

	» For information on the different fields of 
the "Edit Sensor" window, see section 
3.1.1 The fields of the "Edit Sensor" 
window.

3.	 If needed, enter a custom name for the 
new sensor.

	» To easily identify the sensor, we chose 
"humimeter BLO".

4.	 Select the sensor type "LFTD + BLO 
(TCP)" for the humimeter BLO.

5.	 Enter the IP address (figure 8) or 
hostname (figure 9) of the humimeter 
BLO sensor in your network or use the 
network search with the magnifying 
glass icon.

	» See 3.3 Example: setting up a humimeter MF-P-HTD sensor for how to find the 
IP address or 3.2.2 Finding the hostname of your sensor for how to find the 
hostname of your sensor.

6.	 Save the sensor by pressing .

 7 

 8 

 9 
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3.2.1	 Setting up the Lantronix module

Finding the IP address of the Lantronix module 

1.	 Install the "Lantronix DeviceInstaller" software on your computer.

	» The software is located on the provided USB stick under "Lantronix/DeviceIn-
staller/[exe]" and is called "DeviceInstaller.exe".

2.	 Now start the device and connect it to your network.

3.	 Next, open the DeviceInstaller from Lantronix.

4.	 Search for xPico devices in your network 
using the button "Search" (figure 10).

5.	 Click on the xPico module and read out 
the IP address (figure 11).

	» To ensure that the module gets the same 
IP address every time it is restarted, re-
serve this IP address in your DHCP server.

	» If this is not possible, you can also assign 
a fixed IP address in the module itself.

Assigning a fixed IP address in the Lantronix 
module

1.	 Open the determined IP adress in your brows-
er. See Finding the IP address of the Lantronix 
module.

	» Your browser will display an authentication 
window.

2.	 Leave the user name blank and enter "Schaller" 
as password (figure 12).

 10 

 11 

 12 
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3.	 The start window appears:

4.	 Under the tab "Network" you can access the network settings and assign a static 
IP address.

5.	 Enter your network settings.

6.	 Click "OK" to save the changes and "Ap-
ply Settings" to apply the changes to the 
module.

7.	 The device will restart after applying the 
changes.

8.	 After the device is rebooted, you can use it with the IP address set!

 13 

 14 

 15 
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3.2.2	 Finding the hostname of your sensor

To do so: A working DHCP/DNS sever in your network.

1.	 The hostname of the module is related to the last 6 digits of the mac-address of 
the sensor.

	» E.g.: xPico of humimeter BLO: MAC-address 00:80:A3:0000:FFFF:0000 results in the 
hostname C00FF0000FF00

	» Using this function enables the use of the device with changing IP addresses and no 
configuration changes to either the device or the DHCP server.

2.	 You can find the MAC address and hostname of your sensor under 6. Additional 
sensor information,

3.	 or you can use the "Lantronix DeviceInstaller".

	» See 3.2.1 Setting up the Lantronix module on how to install the "Lantronix Devi-
ceInstaller".

4.	 Open the DeviceInstaller.

5.	 Select the option "View", "Device Node 
Text" and then "Hardware Address" 
(figure 16).

	» This will change so the DeviceInstaller 
shows the devices MAC address instead 
of its IP address.

6.	 Now search for xPico devices in your network using the button "Search".

7.	 Click on the xPico module and read out the MAC address.

 16 
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3.3	 Example: setting up a humimeter MF-P-HTD sensor

3.3.1	 Adding a Sensor

1.	 Right-click on the sensor table.

2.	 Select the "Change" option and 
then "Add" (Figure 17).

3.	 Select the MFPHTD (TCP) sensor (Figure 18).

4.	 Now click on the "magnifying glass" (network 
search)

	» Now the sensor search is running (Figure 19).

	» The sensor has been found (Figure 20).

5.	 Select the sensor and confirm it with            
(Figure 20).

6.	 Save the sensor under the Project tab (Figure 
21).

7.	 There are two ways how to start the Senor 
measurement:

	» With the button .

	» Or with a right click on the sensor in the sensor 
table and then select "Start" (Figure 22).

8.	 The sensor measurement has now started.

 17  18 

 19 

 20 

 21 

 22 
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3.4	 Editing a sensor

1.	 Left-click on the sensor so it is selected.

2.	 Right-click on the sensor.

3.	 Select the option "Change" and then "Edit" (figure 23).

4.	 The "Edit Sensor" window will now open 
(figure 24).

	» For information on the different fields of the 
"Edit Sensor" window, see section 3.1.1 The 
fields of the "Edit Sensor" window.

3.5	 Accessing the webinterface of a   sensor (MF-P-HTD only) 

To do so: The sensor must have a webinterface.

1.	 Left-click on the sensor so it is selected.

2.	 Right-click on the sensor.

3.	 Select the option "Webinterface" (figure 25).

	» The webinterface of the sensor will now be opened in your 
default web browser.

	» For further information on how to configure the webinter-
face of your sensor, please contact Schaller Messtechnik 
GmbH.

3.6	 Removing a sensor

1.	 Left-click on the sensor so it is selected.

2.	 Right-click on the sensor.

3.	 Select the option "Change" and then "Remove"  
(figure 26).

	» The sensor will now be removed.

 23 

 24 

 25 
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3.7	 Setting paper type and grammage (MF-P-HTD only)

To do so: A sensor must have been added to set the paper type and grammage and 
there is no active measurement on the sensor (see 4.3 Stopping a measurement).

3.7.1	 Setting the paper type

•	 Left-click on the "PaperType" cell of the sensor so the drop-
down button is visible.

•	 Left-click on the "PaperType" cell again and the drop-down 
menu will open (figure 27).

•	 Select the type of the paper.

3.7.2	 Setting the paper grammage

•	 Left-click on the "Grammage" cell of the sensor so the drop-
down button is visible.

•	 Left-click on the "Grammage" cell again and the drop-down 
menu will open (figure 28).

	» The drop-down menu will show all the grammage options if 
no paper type has been selected for the sensor.

•	 Select the grammage of the paper.

	» The grammage will also be set to empty if the paper type of 
the sensor is set to empty.

	» On selecting the "??" entry, you are able to enter a user 
defined grammage (figure 29).

 27 

 28 

 29 
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4.	 Using the HumiSenseWare

4.1	 The HumiSenseWare (Demo)

•	 The HumiSenseWare (Demo) is a shortcut to open the HumiSenseWare with a 
preconfigured config file. It comes with 5 simulated sensors to demonstrate the 
functionality of the HumiSenseWare.

	» Changes to the configuration of the HumiSenseWare (Demo) can not be saved!

4.2	 Starting a measurement

To do so: One or more sensors must have been added.

4.2.1	 Starting a measurement of one sensor

1.	 Left-click on the sensor so it is selected.

2.	 Starting it with the context menu.

	» Right-click on the sensor.

	» Select the option "Start" (figure 30).

3.	 Starting it with the "Start" button.

	» To do so, press .

4.	 The measurement will be started.

4.2.2	 Starting a measurement of all sensors

To do so: No sensor must be selected.

1.	 Starting it with the context menu.

	» Right-click on the sensor list.

	» Select the option "Start" (figure 31).

2.	 Starting it with the "Start" button.

	» To do so, press .

3.	 Starting it over the menu bar.

	» Select the menu "Measurements".

	» Select the option "Start All" (figure 32).

4.	 All measurements will be started.

 30 

 31 

 32 
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4.3	 Stopping a measurement

4.3.1	 Stopping a single measurement

1.	 Left-click on the sensor so it is selected.

2.	 Stopping with the context menu.

	» Right-click on the sensor.

	» Select the option "Stop" (figure 33).

3.	 Stopping with the "Stop" button.

	» To do so, press .

4.	 The measurement will now stop.

4.3.2	 Stopping all measurements

To do so: No sensor has been selected.

1.	 Stopping it with the context menu.

	» Right-click on the sensor list.

	» Select the option "Stop" (figure 34).

2.	 Stopping it with the "Stop" button.

	» To do so, press .

3.	 Stopping it over the menu bar.

	» Select the menu "Measurements".

	» Select the option "Stop All" (figure 35).

4.	 All measurements will now stop.

 33 

 34 

 35 
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4.4	 Adjusting a sensor (only MF-P-HTD)

To do so: The measurement of the sensor is running.

1.	 Left-click on the sensor so it is selected.

2.	 Adjusting it with the context menu.

	» Right-click on the sensor.

	» Select the option "Adjust" (figure 36).

3.	 Adjusting it with the "Adjust" button.

	» To do so, press .

4.5	 Viewing the database history

For information on how to view the database history, see section 5. Viewing the data-
base history.

4.6	 Changing the language

•	 Left-click on the  icon.

	» A small window will open and show all the available Languag-
es (figure 37).

•	 Now you can select the Language by selecting the representa-
tive flag icon.

4.7	 Copy the current sensor table data to the clipboard

•	 Right-click on the sensor list.

•	 Select the option "Data > Clipboard" (figure 38).

	» The data of all sensors has been copied to the clipboard.

 36 

 37 
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4.8	 Adjusting the graph

4.8.1	 Docking/Undocking the graph

•	 Right-click on the graph.

•	 Select the option "Undock"/"Dock" (figure 39).

	» The graph is now docked or undocked.

4.8.2	 Scaling the Y-axis

The "Humidity / Moisture" and the "Temperature" graph have to 
be scaled separately.

Manually scaling the Y-axis

•	 Right-click on the graph.

•	 Select the option "Scale once Y" (figure 40).

	» The Y-axis has been scaled now.

	» Manually scaling the Y-axis will disable autoscaling.

Enabling/Disabling autoscaling of the Y-axis

•	 Right-click on the graph.

•	 Select the option "AutoScale Y" (figure 41).

	» This will toggle the automatic scaling of the Y-axis.

	» Manually scaling the Y-axis will disable autoscaling.

4.8.3	 Showing the Plot legend

•	 Right-click on the graph.

•	 Select the option "Plot Legend" (figure 42).

	» This will toggle if the Legend is shown.
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4.8.4	 Enabling and disabling autoscrolling of the X-axis

The Timeaxis (X-Axis) of the "Humidity / Moisture" and "Tempera-
ture" graph can not be scaled separately.

•	 Right-click on the graph.

•	 Select the option "AutoScroll X" (figure 43).

	» This will toggle the automatic scrolling of the X-axis.

4.8.5	 Clear the graph

•	 Right-click on the graph.

•	 Select the option "Clear Trend" (figure 44).

	» This will clear both graphs.

4.8.6	 Export graph data

To do so: One or more measurements have to be running.

Export data to clipboard

•	 Right-click on the graph.

•	 Select the option "Export > Clipboard" (figure 45).

	» The graph data has been copied to the clipboard.

Export data to excel

To do so: Microsoft Excel has to be installed.

•	 Right-click on the graph.

•	 Select the option "Export > Excel" (figure 46).

	» A new Excel window will open with the exported data.
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5.	 Viewing the database history

5.1	 Overview over the database history window

No Name

1 Menu ribbon

2 Graph tools

3 Measurement graph

3

1
2
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5.2	 Selecting a sensor

To do so: One or more sensors must have been added and some measurement data 
has been recorded.

1.	 Selecting it from a list of available sen-
sors.

•	 Left-click on the sensor (figure 47).

	» A list of all the available sensors will open.

•	 Select the sensor to view the measurements of by left-clicking on it.

2.	 Selecting it by cycling through the available sensors.

•	 Left-click on the cycle buttons  
(figure 48) to cycle through the available 
sensors.

5.3	 Selecting a measurement of a sensor

To do so: One or more measurements have to be completed or are currently running.

1.	 Selecting it from a list of available measurements.

•	 Left-click on the selected entry (figure 49).

	» The default selected entry will be the currently 
running measurement or the last completed 
measurement if no measurement is currently running.

	» A list of all the available measurements for that sensor will open.

•	 Select the measurement to view by left-clicking on it.

2.	 Selecting it by cycling through the available measurements.

•	 Left-click on the cycle buttons (figure 50) to 
cycle through the available measurements.

	» The default selected entry will be the currently 
running measurement or the last completed measurement if no measurement is 
currently running.
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5.4	 Showing the measurement data

To do so: One or more measurements have to be completed or are currently running.

•	 Left-click on the icon .

	» The selected measurement (within the selected time range) will be displayed on 
the graph.

5.5	 Showing all measurement data

To do so: One or more measurements have to be completed or are currently running.

•	 Left-click on the icon          .

•	 All data of the selected measurement will be displayed on the graph.

5.6	 Selecting a time-frame of a measurement

To do so: A measurement must have been selected.

1.	 Selecting it with the time and date dialogs.

	» The start- and end-time have to be set separately.

•	 Left-click on the "time and date" icon .

•	 You can now set the time and date (figure 51).

	» After changing the time you have to confirm it by press-
ing the "Enter" key.

•	 Confirm the time and date by left-clicking the "OK" 
button.

2.	 Selecting it with the graph tools.

•	 For information on how to use the graph tools, see section 5.7 Graph tools.

3.	 You can reset the graph by right-clicking on the icon .

5.7	 Graph tools

1.	 You can view single measurement values .

•	 Right-click on the graph.

•	 Select the option "Cursor Legend".

	» The graph will now show two cursors and a 
small window displaying the selected measure-
ment values (figure 52).
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•	 Left-click on the "cursor legend" icon .

	» Now you can move the cursors by dragging them over the graph to show the 
measuring values at different points in the graph.

2.	 The "magnifying glass" tool.

•	 Left-click on the "magnifying glass" icon .

	» A small menu will open and you can select between six 
different modes (figure 53) to change how the data in the 
graph is displayed.

	» To select a mode, left-click on its icon.

	» The mouse cursor will change according to what mode is selected.

•	 The  mode will let you select a "window" out of the measurement data to 
display in more detail.

	» The "window" can be chosen at random and only consist of a few single meas-
urements.

	» Left-click on the graph where you want the "window" to start and drag it to 
where you want it to end.

•	 The  mode will let you select a time-frame out of the measurement data to 
display in more detail.

	» Left-click on the graph where you want the time-frame to start and drag it to 
where you want it to end.

•	 The  mode will let you select a measurement-value-frame to display in more 
detail.

	» Left-click on the graph where you want the measurement value frame to start 
and drag it to where you want it to end.

•	 The  mode will overlay the moisture and temperature values.

•	 The  mode will let you zoom into the graph.

	» Left-click on the graph where you want to zoom in.

•	 The  mode will let you zoom out of the graph.

	» Left-click on the graph where you want to zoom out.

3.	 The "hand" tool.

•	 Left-click on the "hand" icon .

	» Now you can move the data shown by clicking and holding the left mouse-but-
ton and dragging the graph.
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5.8	 Selecting a database not in the default path

1.	 Left-click on the "select a different path" button (figure 54).

	» An explorer window will open and 
show the default folder for the sensor 
databases.

2.	 Navigate to the folder where the database is located.

3.	 Select the database by left-clicking on it and confirm the selection by left-clicking 
the "OK" button.

	» For information on how to view the measurements of the selected sensor, see 
section 5.3 Selecting a measurement of a sensor.
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6.	 Additional sensor information

Additional information about your sensor:
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7.	 Notes
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Schaller Messtechnik GmbH

Max-Schaller-Straße 99, A - 8181 St. Ruprecht an der Raab

Tel +43 (0)3178 - 28899 , Fax +43 (0)3178 - 28899 - 901

info@humimeter.com, www.humimeter.com

Schaller Messtechnik develops, produces and sells professional 
moisture meters and turnkey solutions.


	Information about this operating manual
	1.	System requirements
	2.	Installation
	2.1	Operating system older than Win 10
	2.1.1	Installing the .NET runtime 4.6.2

	2.2	Installing runtime
	2.3	Installing HumiSenseWare
	2.4	Overview of the HumiSenseWare window
	2.5	Licencing

	3.	Setting up
	3.1	Adding a sensor
	3.1.1	The fields of the "Edit Sensor" window
	3.1.2	Sensor types

	3.2	Example: setting up a "humimeter BLO" sensor
	3.2.1	Setting up the Lantronix module
	3.2.2	Finding the hostname of your sensor

	3.3	Example: setting up a humimeter MF-P-HTD sensor
	3.3.1	Adding a Sensor

	3.4	Editing a sensor
	3.5	Accessing the webinterface of a sensor (MF-P-HTD only) 
	3.6	Removing a sensor
	3.7	Setting paper type and grammage (MF-P-HTD only)
	3.7.1	Setting the paper type
	3.7.2	Setting the paper grammage


	4.	Using the HumiSenseWare
	4.1	The HumiSenseWare (Demo)
	4.2	Starting a measurement
	4.2.1	Starting a measurement of one sensor
	4.2.2	Starting a measurement of all sensors

	4.3	Stopping a measurement
	4.3.1	Stopping a single measurement
	4.3.2	Stopping all measurements

	4.4	Adjusting a sensor (only MF-P-HTD)
	4.5	Viewing the database history
	4.6	Changing the language
	4.7	Copy the current sensor table data to the clipboard
	4.8	Adjusting the graph
	4.8.1	Docking/Undocking the graph
	4.8.2	Scaling the Y-axis
	4.8.3	Showing the Plot legend
	4.8.4	Enabling and disabling autoscrolling of the X-axis
	4.8.5	Clear the graph
	4.8.6	Export graph data


	5.	Viewing the database history
	5.1	Overview over the database history window
	5.2	Selecting a sensor
	5.3	Selecting a measurement of a sensor
	5.4	Showing the measurement data
	5.5	Showing all measurement data
	5.6	Selecting a time-frame of a measurement
	5.7	Graph tools
	5.8	Selecting a database not in the default path

	6.	Additional sensor information
	7.	Notes

